
Search your entire Premiere Project. Clips. Sequences. Markers. 

Every last bit of Metadata is yours to search.

 Digital Anarchy 
 Smart tools for creative minds.

 www.digitalanarchy.com

AFTERBEFORE



© 2018, Digital Anarchy : Smart Tools for Creative Minds | Powersearch

PowerSearch: Table of Contents

PowerSerach Contents

About This Manual      5

Installation       6

Mac Demo:       6
Windows Demo:      6

Your Serial Number      7

What is PowerSearch?      8

What does PowerSearch search when it searches?   8

Launching PowerSearch     9

How to Use PowerSearch for Premiere Pro   10

Start Screen       10
Indexing and Saving - READ THIS    10
Index Project button      11
Select Groups to Index     11
Load from Save button     12
Skip button       12

Search Bar       13

Save button      13
 JSON vs XMP      13
Index New Items button     14
Re-Index Project button     14
Search Field      15
 Using Quotes in Searches (“quotes”)   15
Re-indexing Individual Files    16
 Why do I want to do this?    16

Continued next page...



© 2018, Digital Anarchy : Smart Tools for Creative Minds | PowerSearch

PowerSearch: Table of Contents

Search Results       17

Markers       17
Clips        17
Sequences        18
Metadata       18
Captions (SRTs)      18
Displaying Search Results     18
Clicking on Search Results     19

Switching between Projects      21

Troubleshooting section      22

Why is indexing taking so long?    22
Why is saving taking so long?    22
PowerSearch panel has gone blank   22
PowerSearch panel keeps reverting to the start screen 22

Other Resources        22

Video Tutorials      22
FAQ       22
Email Support      22
Phone Support      22

 
 



4 © 2018, Digital Anarchy : Smart Tools for Creative Minds | PowerSearch

PowerSearch: Install & Requirements



5 © 2018, Digital Anarchy : Smart Tools for Creative Minds | PowerSearch

PowerSearch: Install and Requirements

About This Manual

While the manual is a good resource, we recommend checking out the videos on PowerSearch to 
really get an understanding of how it works. Often it’s easier to show something than to try to explain it 
with words, especially with something that’s visual to begin with.

However, it can be hard to go into lots of detail in a video, so this manual usually provides more info 
than you’ll find in the tutorial videos. The videos and manual are designed to complement each other.

Online Tutorials

https://digitalanarchy.com/premiere-search/tutes.html

Some great tutorials on the various features, especially Indexing as well on how to use 
PowerSearch with other services such as SimonSays, Trint, and Speedscriber.



6 © 2018, Digital Anarchy : Smart Tools for Creative Minds | PowerSearch

PowerSearch: Install & Requirements

Installation

You can always download the most up-to-date version of PowerSearch from our Demo page. Your serial number 
will activate the demo.

Mac Demo:

https://digitalanarchy.com/demos/psd_mac.html

Download the .dmg file and run the Installer that’s on the dmg.

This will install the PowerSearch panel and associated files into: 
Macintosh HD/Library/Application Support/Adobe/CEP/

Once the installer finishes, it’ll bring up the Digital Anarchy Registration page. Please fill out the registration and close 
the installer.

Restart Premiere Pro and PowerSearch should show up in Premiere under Windows>Extensions>PowerSearch 

If at some point you wish to uninstall PowerSearch completely (this is sometimes helpful in troubleshooting 
problems with a new version), run the Un-Installer. 

Windows Demo:

https://digitalanarchy.com/demos/psd_win.html

Open the .zip file and launch the PowerSearch_Installer.exe. If you are updating or upgrading, you’ll be asked if 
you want to uninstall PowerSearch. Click OK to run the un-installer. (highly recommended)

Click through the installer, agreeing to the license terms. The installer will automatically select the correct directory, 
don’t change this unless you have an unusual system and you know where the panel should go.

This will install the PowerSearch panel, and associated files into: 
C:\Program Files\Adobe\Adobe Premiere Pro CC 2018\CEP\extensions

Once the installer finishes, it’ll bring up the Digital Anarchy Registration page. Please fill out the registration and close 
the installer.

Restart Premiere Pro and PowerSearch should show up in Premiere under Windows>Extensions>PowerSearch

If at some point you wish to uninstall PowerSearch completely (this is sometimes helpful in troubleshooting 
problems with a new version), run the Installer, click OK to uninstall and then cancel the Installer before it re-
installs the plugin. 
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Your Serial Number

After purchasing your plugin, you should see an email with the Subject: Your Serial 
Numbers for Order #XXXXXX

Look for the pink highlighted text in the email and that will have your serial number.

PowerSearch will ask you for the serial number when you first run it within Premiere Pro.

If you have any problems, you can always contact us at cs@digitalanarchy.com or call 
415-287-6069
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What is PowerSearch?

PowerSearch aims to be Google for your Premiere project. A search engine that can find 
anything. We index everything in your project (this can take a few minutes when you first 
launch PowerSearch) and that allows us to easily search any metadata attached to your 
clips, markers in sequences or transcripts/captions in Transcriptive.

It’ll save you hours of time looking for things. You no longer have to scrub through footage 
looking for the clip where “that guy, said that thing about the Anarchist”. Do a search for 
“Anarchist” and everywhere that shows up in clips, sequences or markers will get displayed 
to you like search results in any search engine. Click on a search result and open that clip or 
sequence right to where the search term was said. It’s pretty amazing.

Of course, you need to have transcripts or metadata for PowerSearch to do it’s magic. 
Obviously we think Transcriptive, with it’s ability to use/import A.I. or human generated 
transcripts, the best way to turn all your dialog into text. However, PowerSearch is totally 
agnostic. If you’ve used another tool like Trint, SpeedScriber, SimonSays or any other service 
to get your transcript into Premiere’s Speech Analysis metadata field or Sequence markers, 
PowerSearch will search that data too! Just get the data into Premiere and we’ll find it.

It’s a whole new way of finding things in Premiere Pro and it’s going to change the way you 
work!

What Does PowerSearch Search When It Searches?

- Clips: Any clip or sequence that has a transcript in the Speech Analysis field or in the 
Transcriptive panel. (Some apps like SpeedScriber also put transcripts in Speech Analysis)
- Sequence Markers: Any markers you lay down in a sequence will be searched. Doesn’t 
have to be transcript data. If you’ve used markers to make notes or labels, it’ll search them. 
(web apps like SimonSays put transcripts here)
- Clip Markers: These are attached to the file itself and should go along with it. 
- Metadata: Pretty much all the fields that show up in the File portion of the Metadata panel. 
This includes things like: Description, Copyright, Location, Shot, Scene, Keywords, Tape 
Name, and more.
- Captions: Currently this just means SRT files. However we hope to expand this to other 
caption formats very soon. If you need to use other caption formats just bring in a SRT file as 
well. We realize this isn’t perfect but hopefully we’ll have broader support in v1.1.
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Launching PowerSearch

PowerSearch is a panel, not a plugin. So you can find it by going to 
Window>Extensions>PowerSearch.

When you select it, it’ll open PowerSearch as a floating panel. Like any Premiere panel you 
can dock the PowerSearch panel anywhere. Leave it floating or drop it into the portion of the 
Premiere UI that makes sense and somewhere you can leave it open. It’s better if you don’t 
close Powersearch frequently. PowerSearch needs to index your project. This can take a few 
minutes with big projects. So it’s best to put the panel somewhere in the UI where you can 
leave it be. You CAN save the index file and load it when you start which makes it a lot faster.

Top: PowerSearch is docked  Bottom: Undocked, floating panel
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How to Use PowerSearch for Premiere 
 
 
Start Screen
The Start Screen is the first thing you see in PowerSearch.  Here you can:
1) Index the entire project 
2) Load indexed data that was previously saved
3) Skip to the search section. ONLY do this if you plan on indexing individually items 
manually. If you don’t index anything, PowerSearch won’t find anything. This is useful in a 
very large project when you don’t want to index everything, just specific clips for searching. 
However, normally you’ll want to index everything.

Indexing and Saving - Yes! You need to read this part!
As mentioned, Powersearch needs to index your project. Once this is done the first time, the 
data can be saved, speeding up the process next time you open the project. It can still take a 
couple minutes to load saved data with really large projects. 

The three steps needed to index and save that data are:
1) Select what you want indexed. Speech Analysis (transcripts usually), Markers, or 
Metadata. This is one way of speeding up the indexing by 40-60%... if you only want to 
search Markers, you only need to index those. 
2) Select the Index Project button to do the initial indexing 
3) Select the Save button in the upper, right corner to save the data. (PowerSearch should 
automatically pop up the Save dialog but as a safeguard, you can Save manually as well) 
You’ll need to select from JSON or XMP. For a full explanation of this see the section on the 
Save Button. (page 12) 
4) Next time you open the project, select ‘Load from Save’ to load the index data. 
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Index Project Button
Clicking on the Index button indexes your Premiere project and THIS IS REQUIRED. If you 
don’t click this button, PowerSearch won’t find anything. 

PowerSearch looks into all your metadata, markers, clips, sequences… everything. It then 
makes an index of where all your text is. This makes it incredibly fast when you go to search 
for something. The downside is that, for big projects with lots of clips and metadata, it can 
take a minute or three to do the indexing. So you don’t want to have to do this frequently. 
Luckily you can save and then load that data once it’s indexed.

You can also add new items you import without re-indexing everything by using the Index 
New Items button. (see below)

Select Groups to Index

As mentioned, large projects can take a while to index, like 5 to 10 minutes or longer. By only 
indexing certain types of data, you can cut down the time it takes to do the indexing. In some 
cases you may not need to search all the data, especially metadata. So turning that off means 
PowerSearch won’t have to dig through all that info and can just focus on the important stuff.

Speech Analysis usually means the transcript data saved with clips or sequences. If 
you haven’t gotten your clips transcribed this isn’t important, so you don’t need to have 
PowerSearch checking every clip looking for it. Same with Markers, if you haven’t created 
any, there’s no point indexing it.

Just indexing one data type doesn’t increase the speed by an order of magnitude. Generally 
it cuts it down by half, maybe two-thirds. But if it’s taking 10 minutes to index, that can be 
significant.

Saving the index data as JSON: This is an order of magnitude faster. Once you’ve finished 
indexing, if you save everything as an external JSON file, it’ll save almost instantly. If you try 
to embed the indexed data into the project, it can take almost as long as indexing. We really 
recommend you Save to JSON.
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Load From Saved Button

If you’ve saved your indexed data (Make sure you use the Save button). this button will load it. 
If you don’t have any saved data you’ll just get an error message. 

Loading saved data can still take a few minutes for large projects if you saved as XMP. For 
that reason it’s best to not close the panel. You can switch away from it, selecting a different 
Premiere panel. That’s no problem. But you don’t actually want to right+click on it and select 
‘Close Panel’. Or at least, if you do then you’ll need to reload the index data. Not a big deal  
but it can take a couple minutes.

JSON vs XMP: You can read more about this in the Save Button section. When you save the 
Index data you need to choose XMP or JSON (default). XMP saves the data with the Premiere 
project and JSON saves it as external files. XMP is slightly more convenient but JSON is much, 
much faster to Save/Load. We highly recommend using JSON.

Skip Button

As mentioned, this lets you skip indexing and go straight to the Search section. If you do this, 
PowerSearch won’t find anything if you search! You MUST index something for PowerSearch 
to be useful.

Uh, so why does this exist?

If you have a very large project and only want to search a few clips or one bin in that project, 
this can save you a few minutes by not having to index everything. You can manually select 
those files for indexing. Just click on the ‘Plus’ sign next to any un-indexed file. Once you’ve 
done that you can search those clips. This makes it much faster to use if you’ve got a project 
with hundreds of items and only a few of which that you actually want to search.
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Search Bar

Save Button

In the upper, right corner of the Powersearch UI you’ll see a Save button. When you index 
your project, PowerSearch should automatically save the indexed data. However, this allows 
you to manually save it if you want to be sure. If the indexed data doesn’t get saved, the 
‘Load from Save’ button won’t work meaning you’ll need to index the entire project from 
scratch every time you open PowerSearch. Loading from saved data is much faster.

JSON vs XMP

When saving the Index data, you’ll be asked to choose either JSON or XMP. You can also 
save twice and be able to load from either one. However, what’s the difference?

JSON: ‘Save to External JSON file’ is checked by default. This saves the data locally to your 
hard drive. It’s a much, much faster way of Saving and Loading. However, if you move your 
project, you need to copy the JSON files or re-index. The location where the files are saved is 
shown in the dialog. We highly recommend using JSON.

XMP: When you uncheck the JSON option, PowerSearch embeds the Index data in the 
Premiere project file. So if you move the project file around all the data goes with it. However, 
it’s not fast to save it this way. It can take a few minutes to Save it or Load it later. For very 
large projects, it can take 5 to 10 minutes or more. 
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Index New Items Button (Plus Sign Button)

This will look through your project for new items and index only those items. This should be 
much faster than a  full re-indexing. When you add footage to a project you’ll need to click 
this in order for them to be searchable. Otherwise their metadata won’t be in the search 
index.

Unfortunately this doesn’t work for Markers. If you add new clip or sequence markers and 
need those added to the Index file, you’ll need to re-index individual items manually or the 
entire project.

Re-Index Project Button (Recycle Button)

This will take you back to the Start Screen where you can select Index Project. Everything in 
your project will be re-indexed and will take the same amount of time as it did initially (or 
longer if there are a lot of new items). Useful if you import a lot of files or add markers to a lot 
of clips or sequences.
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Search Field

Just like you would in Google or any search engine, this is where you type in what you want 
to find and hit Enter. Pretty simple.  Powersearch will not start searching until you press the 
Enter key.

Using Quotes in Searches (e.g. “This has quotes”)

Like, most search engines, PowerSearch supports quotes, so if you want to find a word 
exactly, say every instance of “photo” but not ‘photographer’ or ‘Photoshop’, then by using 
quotes PowerSearch will only return results with “photo”.

Otherwise if you type in ‘photo’ without quotes, it’ll return photo, photography, photon, etc. 
You get the picture.

You can see the difference above. Without quotes, the search results return ‘hanger’ and 
‘dangerous’ in addition to ‘anger. With quotes, only ‘anger’ is returned.
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Still blotchy, needs more smoothing.

Re-Indexing Individual Files

If you add markers or text to a file after you’ve done the initial indexing, PowerSearch won’t 
be able to find the new text. You could re-index the entire project, but that might be time 
consuming just for just one or two files or sequences.

Luckily you’ll find a little ‘+’ sign next to each file or sequence. Both in the search results and 
the ‘Indexed Project Items’ table. See below:

Just click on the + and only that file will be re-indexed. It’s a fast and easy way of making sure 
all the data in your project is being searched.

Why do I want to do this?

PowerSearch doesn’t constantly index files. That would slow Premiere down. So if you add 
files or make changes to a clip or sequence (say you add some markers), you may want to 
individually index them. This is much faster than indexing everything from scratch.

Any time you add markers, change the metadata (e.g. add some shot notes, a location, etc), 
or bring in new files, you want to make sure that gets captured in the Index. The Plus sign is a 
fast and easy way of doing that.
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Search Results

PowerSearch can find metadata in all sorts of places. The usual suspects are: 

Markers: It will search both clip and sequence markers. Markers are displayed a bit 
differently than other results. Showing the timecode, Name of the marker, and text content of 
the marker.

Clips (Speech Analysis): PowerSearch will find most things that shows up in the Metadata 
panel. If you’re using it with Transcriptive or other transcription tools, often the Speech 
Analysis field will have the entire transcript. However, it will also search all the fields, so if you 
clips have GPS data showing location, shot or log notes, copyright owner, etc. PowerSearch 
will find it all.



18 © 2018, Digital Anarchy : Smart Tools for Creative Minds | PowerSearch

PowerSearch: User Interface

Sequences: PowerSearch will also search Sequence metadata and show where a search 
term appears in the sequence. This generally means it has to have data in the Speech 
Analysis field and as far as we know only Transcriptive will put data in Speech Analysis for 
a sequence. Most other apps will put it into the sequence marker data. Those results will, of 
course, show up under Marker results.

Metadata: Everything that shows up in the File portion of the Metadata panel is indexed and 
searched. This includes things like Copyright, Location, Shot Name, Keywords, etc. So if you 
search for ‘San Francisco’, any clip or file that has San Francisco in a metadata field will be 
shown. The field it’s in and the entirety of the text in that field will also be shown, as you can 
see below.

Captions: For the moment this just means SRT files. We hope to expand this to most caption 
formats for v1.1. If you have your captions in SRT files, PowerSearch will index those and 
search them. You’ll get results similar to the Metadata results but with timecode, so you know 
where to look for them. These are not clickable, as we don’t know what sequence the SRT file 
is in. However, you can use this to quickly locate the time the caption is at and manually open 
the correct Sequence to that time.

Displaying Search Results

The search results are displayed in three sections:

- Speech Analysis 

 This shows results for clips and sequence. In each case, the file/sequence name is 
shown, the timecode where the search term is spoken, and a short bit of text before and after 
the search term to provide some context.
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- Markers

 This shows both clip and sequence markers. In each case, the file/sequence name is 
shown, the timecode where the search term is spoken, and a short bit of text before and after 
the search term to provide some context.

 

- Metadata

 Shows any results from the metadata of clips or sequences. The file name is shown 
along with the field name and the entire contents of that field. So if the Location field says 
‘Mission Neighborhood, San Francisco, CA USA’, you’ll see all of that even though you only 
searched for ‘San Francisco’.

- Captions

 Shows results from SRT files you have in your project. This will show the text and 
timecode of the search result. You can then locate the Sequence the SRT file is part of and 
open it. Unfortunately, clicking on the search result will not automatically open the Sequence. 
We do hope to improve both the types of caption files we can search and add the ability to 
click on them by the next version of PowerSearch.

In the Upper, Right corner there are tabs that allow you to quickly jump to the section you’re 
looking for. Depending on what you’re searching for you may have a lot of search results, so 
these can be handy shortcuts to get to the section you think will have the relevent result.

Clicking on Search Results

As with any search engine, clicking on the search results takes you to where that result links to. 

Clips (in the Speech Analysis section of the results): If the search result is in a clip, the clip will 
be opened in Premiere’s Source panel and the playhead will jump to the time of the search 
result.

Sequences: If the search result is a sequence, that sequence’s timeline panel will be opened 
and the playhead will jump to the time of the search result. (Actually two seconds before 
where the word is spoken)

Markers: If it’s a Sequence marker, clicking opens the sequence the marker is in and moves 
the playhead to that marker. If it’s a Clip Marker then it’ll be opened in the Source panel.
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Metadata: The clip the metadata is attached to will be opened in the Source panel. Since 
there is no timecode related to these fields, the playhead is always at 00:00.

Captions: Like metadata this is more for informational purposes. If you click on it, it’ll open the 
caption file itself which isn’t as useful as it could be. So find the result you’re looking for and 
manually open the Sequence to the time noted in the search result.
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Switching Between Projects

Newer version of Premiere allow you to have multiple projects open. This can cause 
PowerSearch a bit of confusion. So if you switch projects and then access PowerSearch, it’ll 
tell you that you have a new project active and to index that project. Clicking on the Re-Index 
button will take you to the Start Screen where you can index the project or Load from Save.

You’ll notice when you go back to PowerSearch after switching projects, you get an error 
message saying the project has changed and the only active button is the Re-Index button (the 
red arrow in the above image points to it). Click Re-Index to go back to the Start Screen and 
load the index data for that project.

NOTE! : When you click Re-Index you’ll get a dialog asking if you’re sure you want to Re-
Index your project. Clicking ‘Yes’ just takes you to the Start Screen. It doesn’t delete any data. 
It does look a bit scary though.
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Troubleshooting section 

My project is taking a really long time to index

You may have too many files in your Premiere project. If you start getting over 1000 items 
in a single Premiere project, PowerSearch is going to take a long time to index it. Frankly, 
Premiere usually becomes difficult to work with if you have so many items, so you might want 
to consider breaking things up a bit.

Also, when indexing, try only indexing Markers or Speech Analysis. This will cut the 
indexing times down by about half. 

The index data is taking too long to save

Try saving to JSON. This is the default and what you should be saving the index data to in 
most cases. XMP (the other option) is very slow to save to the Premiere project. If you have a 
lot of footage and metadata in your project, saving to XMP could take a long time.

PowerSearch panel has gone blank

This usually indicates the panel has crashed. Close the panel and restart it. You might want to 
restart the computer as sometimes this can indicate that memory has gotten overloaded. A 
restart will clear out memory which does wonders for applications. (that’s why every support 
person has you restart your computer)

PowerSearch panel keeps reverting to the Start Screen

This usually indicates the panel is crashing. Try restarting your computer. If you’re trying to 
Load from Save, you may also need to re-index from scratch. Sometimes the index file gets 
corrupted and the best solution is just re-index. 

Other Support Resources

Video tutorials:  https://digitalanarchy.com/premiere-search/tutes.html

FAQs: https://digitalanarchy.com/premiere-search/faqs.html

Email support: cs@digitalanarchy.com (7 days a week)

Phone support: 415-287-6069 (Usually 10-5 PST, Mon-Fri) 
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